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Chapter 1 - Product Information

Esco Voyager is a software system for monitoring and programming multiple Esco devices. The
main features include:
e Remote Monitoring and Data Logging:
o Automatic, continuous monitoring of device parameters (Temp, CO2, RH, etc.).
Viewing and graphing device parameters in real-time.
Saving and exporting log data in various formats.
Automatic emailing of log data at user-defined intervals.
Download of data logs from equipment memory (only for devices with built-in
data logging memory, i.e. CO2 Incubators, Ultra-Low Temperature Freezers)
e Alarm
o Alarms when exceeding a user-defined parameter limit
o Automatic email alerts
o Documentation of all alarms with time/date stamp
e Remote programming and equipment configuration
o Development of programs using a graphical interface, for subsequent download to
device memory (only for equipment with program functions, i.e. Forced
Convection Laboratory Ovens and Incubators).
o Configure devices remotely (set points, time, local alarm limits, etc.).

©]
©]
O
o

Esco Voyager can be used for the following equipment:
e Lexicon — Ultra-Low Temperature Freezer
e Celculture — CO, Incubator
e |sotherm — Forced Convection Oven
Isotherm — Forced Convection Incubator
Isotherm — Natural Convection Incubator
Isotherm — Low Temperature BOD Incubator
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Chapter 2 - Installation

2.1 System Requirements

e Operation system : Windows 2000, XP, 7, and Windows 2003 Server.
e Memory :512 MB

e Hard disk space :1GB

e Interface : USB/RS232

e Prerequisite Software : .NET Framework 2.0 (included)

Windows Installer 3.1 (included)
Internet connection is required for auto mailing feature

RJ45 (RS485) to USB Converter requires a correct driver to work.
e  Windows 98 & ME — for Windows 98 and Windows Me (incompatible with Voyager)
e  Windows XP —for Windows XP, Vista and 7 32 bit
e Windows Vista x64 — for Windows Vista and 7 64 bit
e Linux —for Linux (incompatible with Voyager)
The driver is included in the USB-Serial Converter | ATC-820B folder in the CD/DVD.

2.2 Device Requirements

e Lexicon — Ultra-Low Temperature Freezer v.1 (currently unavailable)
e Celculture — CO, Incubator (CCL) v. 1.3.1
Isotherm — Forced Convection Oven (OFA) v. 1
Isotherm — Forced Convection Incubator (IFA) v. 1
Isotherm — Natural Convection Incubator (INA) v. 1 (currently unavailable)
e |sotherm — Low Temperature BOD Incubator (IFC) v. 1
The device require RS485 port connection
Please check the firmware version of the device before attaching it to the Voyager system

2.3 CD/DVD Menu Options

o Install Voyager — to install the Voyager software

Read Voyager Manual —to open the attached Voyager manual (Adobe Reader required)

Install Adobe Reader — to install the Adobe Reader Software

e Read Converter Manual — to open the attached RJ45(RS485) to USB converter manual
(Adobe Reader required)

e View All Files — to view the files and folder structure in the CD/DVD

Monitoring, Programming and Datalogging Software I Egco



2.4 Installation Steps

1.

Run Setup
Double click setup.exe.

Checking Prerequisites

If the Operation System doesn’t have .NET framework 2.0 and/or Windows Installer

3.1 installed, the software’s setup form will appear.

® coVoyager Setup

Far the following components:

Far the following components:

indows Installer 3.1

Please read the following license agreement. Press the page down key to
see the rest of the agieement.

_NET Framework 2.0

Please read the fallowing license agreement. Press the page down key to
see the rest of the agreement.

SUPPLEMENTAL END USER LICEMSE AGREEMENT FOR ~
MICROSOFT SOFTWARE ["Supplemental ELILA")

IMPORTANT: READ CAREFULLY - The Microsoft operating spstem
components accomparying this Supplemental ELLA, including any
"aniine" or electioric documentation [0S Components") are subjsct

to the terms and conditions of the agreement under which you have
licensed the applicable Microsoft operating system product described
below [gach an "End User License Agreement” or "ELILA" and the
terms and conditions of this Supplemental EULA. BY INSTALLING,  «

Wiew ELILA for printing

Do you accept the terms of the pending License Agreement?

If you choose Don't Accept, install wil close. To install you must accept

this agreement
| [ Dontacoent

Accept

MICROSOFT SOFTWARE SUPPLEMENTAL LICENSE TERMS ~
MICROSOFT .NET FRAMEWORK 2.0

MICROSOFT WINDOWS INSTALLER 2.0

MICROSOFT WINDO'WS INSTALLER 3.1

Micrazoft Corporation (or based on where you live, one of its affiiates)
licenses this supplement to pou. If you are licensed to use Microzsoft
"windows operating spstem software [the “software”), you may use

this supplement. You may not use it if you do not have a license for

the saftware. You may use a copy of s supplement with sach

validiy licensed copy of the software, v

“Wiew ELILA for printing

Do you accept the terms of the pending License Agieement?

1f you choose Dort Accept, install wil close. To install you must accapt

this agreement.
| Don't Accept

Accept

Click Accept button to continue with the installation, and the software setup will

commence.

® EscoVoyager Setup

=L Installng NET Framewark 2.0...

Cancel

You may be asked to reboot the computer prior continuing Voyager installation.

® EscoVoyager Setup

G

Details >>

£ Setup must reboot before procesding.

3]

Choose “es' ta reboot now or Ma' ta manuslly rebaat later

Yes Mo
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3. Esco Voyager Installation
Click next to continue.

& EscoVoyager ]

‘Welcome to the EscoVoyager Setup Wizard

The installer will quide wou through the steps required to install Esecvoyager on your computer,

WARNING: This computer program s protected by capyright aw and intemational eaties.
Urauthorized duplication or distibution of this program. ar ny potion of i may tesul in severs civl
or criminal penalties. and wil be prosecuted to the maimum extent passible under the law.

4. Select Installation Folder
Click “Next >” to continue.

FscoVoyager 5%

Select Installation Folder

The installer willinstall EscaVoyager ta the follawing folder,

Toinstallin this folder, click "Nest". Toinstall to a different folder, enter it below or click “Browse'"

Folder.

C:\Program Fles\E soo\Essaoyager' Bgowse.
Disk Cost

Install EscoVoyager for yourself, or for anpone who uses this computer.

¢ Everyone

& Justme

5. Confirm the installation by clicking “Next >”

& EscoVoyager

Confirm Installation

The installer is 1eady to install Esca¥oyager on pour computer

Click "Next" to start the installation.

Carcel < Back {

Monitoring, Programming and Datalogging Software I Egco



6. The installation will commence

i EscoVoyager

Installing EscoVoyager

Escol/opager s being installed

Please walt

uer |

7. Finish installation.

Click Close to complete installation.

1% EscoVoyager

Installation Complete

Click "Close™ ta exit

El=6

2.

EscaVoyager has been successfuly instaled.

Please use Windows Update (o check for any criical updates ta the NET Framework.
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Chapter 3 - Connecting the Devices

Esco Voyager connects to devices using RS485 communication protocol and EscoBus
addressing protocol through either RS232 or USB port. Voyager also uses common CATS5 cable
(more commonly known as LAN cable) with RJ45 connectors as a connecting wire between
devices, also PC and device.

Since common PC do not normally use RS485 protocol, a converter is required — either RJ45
(RS485) to USB or RJ45 (RS485) to RS232.

i aee o)

Note: At the end of the daisy chain, terminate the connection.

To set the Escobus address for the device, please check the device’s user manual.
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Chapter 4 - Operating Esco Voyager

4.1 Starting Esco Voyager
Double click Esco Voyager shortcut on the desktop or click START menu and select All
Programs | Esco Voyager | Esco Voyager to start Esco Voyager.

At Startup the Voyager will display a Login dialog Box.

Login Esco Voyager

ESCCDO

WORLD CLASS. WORLDWIDE.

Password

Enter user name and password and click OK button to login Esco Voyager. If this is the first
time the software run, then enter these information:

User Name: admin

Password: admin

After login successfully, the main form will be displayed:

| WORLD CLASS, WORLOWIOE

Useriadnin
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4.2 Locking and Unlocking Esco Voyager
In main form, click menu File > Lock or press Ctrl + L to lock Voyager
Enter password to unlock.

fxca Vayeger,

"ESCO

WORLD CLASS. WORLDWIDE .|
Spitem s bocked,plaase sets passwesd o ok

UserNane [sdmn

Passwond ||

4.3 Working in the Background
When the user closes main window, Voyager will continue to run in the background to monitor
the devices and send alerts.

Esco ¥oyager Is Still Running x
Esco Yoyager will continue ta run sa that you can acquire data
From chambers and receive alsrts

The user can either close the Voyager or open the main window by right clicking on the
Voyager icon present in the system tray:

Show Main Window

I Exit.

<

4.4 Configuration
To open configuration, click on Settings in the main window. Configurations dialog is shown as
below:
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4.4.1 Devices

" Configurations gl
Devices
Device Mame Device Type Controller Type COM Port EscoBus Address
Usere OF&_1 OFa OF& COM1 5
Mew Device ] [ Edit Device: ] I Delete Device ]

This configuration block gives a consolidated view of all the devices and allows the user to Add,

Edit and Delete Devices.
e Add New Device

Click on “New Device” to open the New Device dialog. This is same as adding a

device from the Main Window (see next chapter).

“% New Device

Device Name
Device Type
Device Type Infio
Controller Type

COM Type

COM Part
EscoBus Address

®
OF4_1 oK
OF&

5

<

. Edit Device

Click on “Edit Device” to edit the selected device.

) Delete chamber

Click on “Delete Device” to delete selected device.
Note: Deleting a Device will delete all related measures.

Monitoring, Programming and Datalogging Software I E;CD



4.4.2 Mail

™ Configurations El
Devices Mai Selting
Mail Seting
Users SMTR Hast | smitp. MyCompary. com | (3mtp MyCompany. Com]
ST P )
Sender Name | amin@MyCompany. com | MyHame@MyCompany o
Password ‘ XXXXXXXXXXXXXXX ‘

Require 55L

Set Email settings for Data Logging and Email Alerts Services.
e  SMTP Host : Set SMTP server address. Like Smtp.MyCompany.com.
e  SMTP Port : Port of SMTP.
e  Sender Name : Sender’s Email Address. Like MyName@MyCompany.com.
e  Password : Sender’s Email Password.
e  Require SSL : Some SMTP servers need SSL.
4.4.3 Users
% Canfigurations El
Devices Users
Mail Setting User Name: Role: Note
admin Admin
oper Operatar
addUser | [ Delete User | [ Edit Usen

ECCD IVoyager*



This configuration block shows the user list having access to Voyager. The user can have one of
the two levels of access:

e Operator has access to all functions except configurations.

e Admin has access of all functions.

e  Add User
Click “Add User” button to open new user dialog as following:
% User Editer E\
User Name |
Role Operator v
Note
Passward
Confirm
e  Options:
o User Name: User name of the new user cannot be same with existed users.
o Role: Role of the new user.
o Note: Note of the new user.
o Password.
o Confirm: Confirm of password, must be same with password.
o Click “OK” button to save new user.

e  Delete User
Click “Delete User” button to delete selected user.

e  Edit user
Click “Edit User” button to open edit user dialog as following:

=% User Editer

Rl [opeso .

Mate

Click “OK” to save.
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Chapter 5 - Device Block

5.1 Adding a Device (from the main window)

Fxco Vayeger

ESCD

WORLD CLASS. WORLDWIDE .|
Sputem s bocked,plaase st passwesd o wioch.

In the Main form click on Add device link to add a New Device.

" New Device ‘z
DeviesMame [OF&t | [ ok ]
Device Type

Device Type Infio
Controllr Type

Programmable

COM Port | COM1

I

EscoBus Addiess |5

R

The user has to enter the following options:

Device Name: A suitable Name for the Device.
Device Type: Select Type Of Device

COM Port: Select COM Port the Device is connected.
EscoBus Address: Set EscoBus address of the Device.
Click OK to save.

For each device added a device block is added on the main window as shown below:
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5.2 Edit/Delete Device

Right click on the Device Block and click on the “Device” - “Edit” menu item to edit the
properties of the Device.
To delete the Device Click on “Device” = “Delete”.

OFA_Unit_1

Click to start measure Measure

Program

5.3 Open Program Editor

Right Click on the Device block and click on the “Program” menu item to open the Program
Editor.

OFA_Unit_1
Click to start measure

Measure 3

Device »

See section Program Management for more details.
NOTE: Programming functionality is available only for Laboratory Ovens and Incubators (OFA, IFA, INA).
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file:///C:/Users/Moortus/Downloads/User%20Manual%20v%202.0.0.0.docx%23_Measure_management

5.4 Measure Management

Left click on the Device Block or right click and select “Measure” - “Start” menu item. This
will open the Measure Configuration window. Once the measure is started, the user can
Pause, Resume or Stop the measure by right clicking on the device block and clicking on the
respective menu items.

OFA_Unit_1

Click to start measy|

oo

| Measure Start

T oo o
Resume

Stop

See section Measure Management for more details.

5.5 View Device Status

Once the measure is started the user can view the real time sensor readings on the device
block. These values are updated at the measure monitor rate selected while configuring the
measure.

ESCD

WORLD CLASS. WORLDWIDE.

OFA_Unit_1

Set Temperature $30.0°C
Current Temperature : 35.0 C
Measure is Running..

Add Device
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5.6 Export Data Log

The user can export the data acquired by Voyager into an Excel or Text file by clicking on the
“Export Data Log” > “Voyager Log” > “Data Log”. The user can also export the

communication log of Voyager by clicking on “Communication Log”.

OFA_Unit_1

Set Temperature
Current Temper
Measure is Running..

+30.0'C

Open Graph
Program

Measure »

Device »

[ oomoni ]

Communication Log

5.7 Export Device Log

For Devices with built-in data logging capabilities the user can export the Device Data Log by
Clicking on “Export Data Log” - “Device Log” > “Flash Data”. The User can also view the
Event Log of the Device by Clicking on “Event Log”.

ULTF_Unit_1
Set Temperature

. -80.0 C

Current Temper
Measure is Running..

Open Graph
Measure »

Device »

Export Data Log » Voyager Log >

Flash Data

Event Log
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Chapter 6 - Program Management

A program is a sequence of one or more temperature steps which will be maintained by the
device. The user can create a program using Voyager and export it to the device or save it into
an external file which can be used for future programming. Program can also be imported
from an external file or device.

NOTE: Programs are only for devices with program functions, i.e OFA, IFA and INA.

6.1 Open Program
To open a new Program right click the mouse on the Device you want program and Click on
“Program” as shown below:

WORLD CLASS. WORLDWIDE.

OFA_Unit_1
Click to start measure

Device »

This will open the Program editor as shown below.
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6.2 Edit program

% OFA_Unit_1 - Program Editor

Fle Edk Wew Chart
Y]

M Panel -

Edit OFA_Unit_1's Program Lm/l -_n
Double click to 2dd pont, Double ciick with shil nnotation -_u
-:) Pressing ak key to ciag.and move poini o annatationPYess delete kay 1o delste annotation. Press F2 key o edit annotation. -- -

3000 1

2500 +

2000 +

1500 +

Temperature (°C)

=
=}
=}
t

500

—
i
_’—l

Step Table Annotation TabIeJ 45 15 a0
Step Time (Mlnutesl

| Program s.
lemp!mue o Step Time Mirutes] &
1 50 18
2 020 18
3 1|0 17 @
Press kay Enter to confirm editing. Press key Esc or dick any other place to cancel ediing, OFf_Unit_L | Cff-ine | .

The Program Editor has the following Sections:

e Maessage Panel: Prompt operation guide, error messages and warning messages.

e Graph Editor: Displays program curve. Step points and annotations position can be
moved in this area. The X axis is total time (minutes) of a step point. The Y axis is
temperature value of the step.

e Step Table: List steps in the program. Steps values can be edited in this table.

o Temperature (°C) : Temperature value of the step. Editable.
o Step Time (Minutes) : Heating time of the step. Editable.
e Annotation Table: List annotations. Annotations position value and text can be

edited.

Program Steps | | Annotations

= v Text

1 76T 60.67 Step 1 |

2 2106 M7 Step 2
o X : X axis value. Editable.
oY 1Y axis value. Editable.
o Text :Text of annotation. Editable.
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6.2.1 Edit Step Point
The following are operations for editing a step point:

e  Select a Step Point:
Click the step point to be edited in the Graph editor. The selected step point is
marked with red circle round as shown in the below picture. The corresponding row
of the selected step point is highlighted in Step table.

% OFA_Unit_1 - Program Editor

Fle Edt  Vew Chart
R T A
Edi in_1" L
4 it gFA_Ur\:leldj 's Program .
:) ogiain saved. - .
. N
3000 1 T T T T T
2500 F e
H
-—
= i
O 2000 i ]
o ~—
g Selected step point
g 1500 1 ]
o '—
a
&
o
= 1000 + [ >
(20 Mins, 99.7 °C )
Step 1
500 + @——
0.0 + t + t t t
0 15 30 45 60 75 an
I/ ~~=p Time (Mi )
| Corresponding Row of
[ Frogram Steps | Annotations L Selected Step
Temperature ['T] Step Time [Minute3) ~
1 435 17
FE 2 ]
3 1378 16 &
Chick Program -> Edit, to edit the Graph OFA_Unit_1 | Off-ine | .

You can also select a step by selecting a row in Step table. Selecting a row in Step
table will highlight the corresponding step point in Graph editor.

° Insert a Step Point:
Double click at the position where the step point is to be added or Right Click at the
position click “Add Point”. A step point will be inserted at that position.

e  Delete a Step Point:
Select a step point. Press “Shift” + “Delete” key or click menu “Edit” - “Delete
Point” or right click on the point you want to delete and click “Delete Point”.
Voyager will prompt confirming message. Click Yes to delete the selected step point.
To delete all step point, click menu “Edit” > “Delete All Points”.

e  Move Step Point:
There are 2 ways of moving a step point.
o One is to move Step Point in Graph editor: Select the Step Point and drag it to the
required position.
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o Another is edit position in Step Table: Select the Step Point in Graph editor. The
corresponding row of the selected step point is highlighted in Step table. Edit
Temp and Step Time value in Step table. The step point’s position will change
according to Temp and Step Time value.

6.2.2 Edit Annotation

The following are operations about editing annotation:
e Insert an annotation:

Right click at the position in the Graph editor where you want to add the Annotation
or press the “Shift” key and double click. A text editor prompts at the click position.

3000

2500 +

i

2000 +

1800 +

Temperature (°C)

1000 +

500 { &¥—m

oo

t + +
a 15 30 45 B0 7
Step Time (Minutes)

a0

Type annotation text and click key enter to confirm editing. Press key Esc or click
other place to cancel annotation editing.

The new annotation is shown below:

3000 +
2500 fo=mod
i
—
G i
© 2000 4 |
= - —
e
s =
£ 1500 1 Step Point 3
@ —
3 H
£ Sitep 2 i
= 1000 + >~
Step 1
500  ———
0o t t + + +
[t} 14 30 45 60 T4 a0
Step Time (Minutes)

L4 Select an annotation:

Click annotation to select it. Selected annotation will be highlighted. Corresponding
row of the selected annotation also will be highlighted.

ECCD IVoyager*



3000 +

500 +

0o

2500 + e
1

—
1

G oo i

@

g i Selected

& 1500 1 Step Point i

i Annotation

£ Step 2 i

= 1000 1 -—

Program Steps | | Annolations

1
2

®
767
2706

¥
BOE7
1M1.77

Test

Corresponding row of
the selected Annotation
t + : : t
a0 a5 75 90
Step Time (Mj
Step1
Step 2

3

4706

150,73

Step Point 3 ]

You can also select an annotation by select a row in Annotation table. Selecting a
row in Step table will highlight the corresponding annotation in Graph editor.

Delete an Annotation:

Select an Annotation. Press key “Delete” or click menu “Edit” - “Delete
Annotation”, system will prompt confirming message. Click Yes to delete the
selected annotation.

Edit an Annotation:

Select an annotation. Press key F2 or click menu Edit-Edit Annotation. The
annotation editor will display like inserting an annotation. Change annotation text
and press key Enter to confirm editing.

6.2.3 Import and Export Program

Program can be stored in 2 ways:

External file: Program can be saved to or imported from external program file
(*.prg).

Device Memory: Program can be saved to or Imported from device’s memory.

The File menu contains sub menus to load or save program.

Menu | Description
File
Import Program
From File Show open dialog to select an external program file.

From Chamber Import program of device memory.

Save Program

To File Save program to external file.

To Chamber

Send program to Device’s memory.
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6.2.4 Operations in Graph

The following is operations about graph. These functions are available in tool bar. Same
operations are available in measure form.

Menu | Description

Chart

Copy Copy image of graph to clipboard.

Save Image As ... Open save dialog to save image of graph.

Print Print image of graph

Zoom Zoom’s current graph pane.

Un-zoom Undo zoom current graph pane.

Set Scale To Default | Set graph scale to default.

Expand Horizontal Expand X axis.

Shrink Horizontal Shrink X axis.

Expand Vertical Expand Y axis

Shrink Vertical Shrink Y axis.
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Chapter 7 - Measurement

7.1 Measure Configuration
Left click on the Device Block or right click and select “Measure” - “Start” menu item.

OFA_Unit_1

Click to start measy|

‘ Proaram

o

=

This will open the Measure Configuration window.

% Measure Configuration ['X|
Measure Mame | Unit_1_Measue_2011-04-07_11-23
== = = aK

Wonior Itervel Hirtes

Measurement
Details

Measure Note |

OsetPant [0 ]
® Run Frogiam

@ Fun Exist

© Load Pragram From File settings

File Path | |
Fiunning Time :

) StartImmediately R‘;?[::‘s
O Start At [ Thusasy . bpi | _

[ Endat | | [ ]

Data Logging

Document Peiod | Evay day Da;:t:’::s'"g
Daslie (1138 ommr——ey

Save To Spreadsheet
SavePath  |C:Woyager Files | D

Auto Email

Rieceiving Address | MyEmailédchess@myCompnay. com J

Export HTHL
SawsPath  |C:Woyager Files | D

The user has to enter the following options in the “Measure Configuration” dialog:
e  Measure name : Not empty. Name of the measure.

e  Device : Device to be addressed.

e Monitor interval : Rate at which data will be acquired.
e  Measure note : Notes of the measure.

e  Program or Set Point:
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For programmable devices the user can either run the device at a constant

temperature, In which case he has to enter the “Set Point” or he can run a program.

In case he wants the device to run a program he can either choose to run the

program already loaded into the device or he can export a new program from a file.

NOTE: These options are not available for Non Programmable devices (ULT Freezers, CO,

Incubators and IFC)

Running Time : Specify running time period.

o Start Immediately: If this option selected, measure starts when OK button clicked.

o Start At : If this option selected, measure will start at the specified time.

o End At: If this option checked, measure will end at the specified time. Else
measure will run until user clicks stop menu.

Data Logging : Enable Data Logging. If enable, checked documentation services
(saving spreadsheet, sending email, or exporting html) will be executed in specified
period.

o Document period: Period type of datalogging. Can be every day, every week or
every month.

o Date/Time: Detailed period value. Date is different according to document period.
The following table list date values of Period values:

Document period Date values

Every day -

Every week Sunday, Monday, Tuesday, Wednesday,
Thursday, Friday, Saturday.

Every month 1-31

O Save to Spreadsheet: Enable auto save measure data to spreadsheet file. These
spreadsheet files are saves at “Save Path”.

o Auto Email: Enable auto send email of measure data. The receiving email is
specified by “Receiving Address”.

o Export HTML: Enable export measure data to html files. These files are saved at
“Save Path” under “Export HTML”.
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7.2 Measure Window

Once the measure is started the Voyager keeps acquiring data from the Device and updating
the Measure Graph. The user can view the measure window by right clicking on the Device
Block and clicking on “Open Graph” menu item.

% OFA_Unit_1_Measure_2011-04-07_10-5B - Measure

File Wew Run Set  Options
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OFA_Unit_1_Measure_2011-04-07_10-58
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J ‘ .
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127 Message Panel ‘ T T
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Measure Curve Graph

Temperature (“C)
o
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o
o
L
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L

o2 | ]

00 4 , , \ \
Measure Data |’ ' ' '
00:0) 0o 12:00 18:00 00:00
Time
=

\

Messure Dala \ L

Time \] Run Time [Minutes] | Actual  Setpoint | Note

(Wx 1 1] Measure:OFA_Unit_L_Measure_2011-04-07_10-58 | COM1 | 9600,8,1,Hone | Start Time:10;58:43 AM | End Time:Infinite

Measure data table columns definition:
e  Time: Measure record time (format like “20011-04-5 13:34:56").
e Run Time (Minutes): Minutes from begin to record time.
e Actual: Actual sensor value.
e  Set Point: The Set Point Value.
e  Note: Editable. Note the record.
Operations on graph are listed at section 0 6.2.4 Operations in Graph.

7.2.1 Pause, Resume, Stop Measure

. Pause
To Pause the Measure either click “Run” = “Pause” menu item or click on the Pause
icon on the toolbar.

4% OFA_1_Measure_2011-04-07_19-52 - Measure

File  wiew Run  Options
LEE B8 32

OFA_1_Measure_2011-04-07_19-52
5 Messure s running
D

‘ E4$ T
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. Resume

To Resume either click “Run” = “Continue” menu item or click on the Resume icon
on the toolbar.

% OFA_1_Measure_2011-04-07_19-52 - Measure

File  Wiew | Run | Options
el g G b S
OFA_1 Ml P ' 19-52
) Measure
i
“) [ stop
‘ 84 i T T T

e  Stop
To Resume either click “Run” = “Stop” menu item or click on the Stop icon on the

toolbar.
*% OFA_1_Measure_2011-04-07_19-52 - Measure.

Fie View [ Run | options
|l s M
oFA_1_wmg | Pause 7_19-52
=y Measure
G
") [
‘ 84 t T

7.2.2 Set Device Parameters
e OFA,IFA, INA and IFC
Set Temperature: When the Device is maintaining a constant Temperature the user

can set the Device Temperature by clicking on “Set” - “Device Temperature” menu
item as show below:

% OFA_1_measure_2011-04-07_21-27 - Measure

Fie Wiew Run [ Set | Options
E [l [l | B Device Temperature L =

OFA_1_Measure_2011-04-07_21-27

(3 Measue s unring

[
NOTE: The user can set the temperature of OFA, IFA or INA only when they are not running a
program.

) Ultra Low Freezers

Set Temperature: The user can set the Freezer Temperature by clicking on “Set” >
“Freezer Temperature” menu item as show below:

% ULTF_Unit_1_Measure_2011-04-07_21-14 - Measure

Fie Yiew Run | Set | UnitData  Options
E [m D ‘\{ Freezer Temperature ~

ULTF_Unit_1_M Freezer Time

( i) Measure iz running.
~

‘ 84 i T T
Set Time: The user can also set the Freezer Time by clicking on “Set” 2> “Freezer
Time” menu item.
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7.2.3 Read Device Data
The user can read Data from Devices which have in-built memory for Data Logging. These
Devices include Ultra Low Freezers and Co2 Incubators.

e  Read Data Log
The user can read the Device Data Log by clicking on “Unit Data” - “Data Log”.

=% ULTF_Unit_1_Measure_2011-04-07_21-42 - Measure

Unit Data | Options

00 [0 [ )8 #y| | eventiog

File View Run S

‘ Data Log ho

ULTF_Unit_1_Meast
( 1) Measureis unning. . Sensor Data
g

$ . :
e Read Event Log

The user can read the Device Event Log by clicking on “Unit Data” - “Event Log”.
. Sensor Data

The user can read the real time sensor values by clicking on “Unit Data” = “Sensor

Data”.

‘ 84

7.3 Email Alerts

If email alerts are enabled the Voyager will notify the user via Email incase of any Alarm
conditions like communication errors with device or device parameters going beyond the
specified High/Low limits. To enable email alerts click on “Options” = “Email Alerts” menu
item.

% ULTF_Unit_1_Measure_2011-04-07_22-06 - Measure

File  %ew Run  Set  UnitData | Options

005 05 8 1y ot 5| 1 oeeegons
E-Mail Alerts |

ULTF_Unit_1_M e 2011
il) Measure is running

(
Y

e

The Voyager will then prompt the user to options window as shown below:

% Email Alerts

O Disable

@ Enable

Riscsiving Addrass | ddess@rpCompang som

Click on “Enable” and enter the email addresses of the users who will be notified in case of
errors. Multiple Email Addresses can be entered with comma (;) separators.

NOTE: For Email Alerts to be sent the user has to previously enter the Email Settings in the Configuration
Window. See Section Mail Setting for more info.
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7.4 Data Logging

The user can change the Data Logging settings while the measure is running by clicking on

“Options” - “Data Logging”.

2% ULTF_Unit_1_Measure_2011-04-07_22-06 - Measure

File Wiew Run Set Unit Data Options

OG5 5 By o 5 Cetalogamg

ULTF_Unit_1_Measure_2011 B )RE
( \i) Measure s tunming...

‘ a4 i T T T
The Voyager will prompt the below window:
% Auto Save Settings EHE‘@‘

O Disahle
@ Enable

Docurment Period
Date/Time 101212 PM -

Save To Spreadshest

SawePath | Copager Files

Auta Email
Receiving Address |myAddress@myEumpany.com

Export HTML
1L

SawePath | Citvoyager Filsd

[ oK ] [ Cancel ]

Make the required changes and click OK to save the changes.
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